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Chapter 1 

AppsRules Suite Installation Overview  

The AppsRules Suite is a set of five integrated applications that work with Oracle 
Applications to define business processes, enhance security, and safeguard data 
integrity: 

• AppsForm modifies the security, navigation, field, and data properties of Oracle 
Applications forms. 

• AppsFlow works with Oracle Applications Workflows to define and implement 
business processes. 

• AppsAudit tracks changes to the values of fields in database tables and displays 
reports that present information about changes to each field. 

• AppsControl applies change control to Oracle Applications fields — it can moni-
tor change, require a reason for a change, or require approval for a change. 

• AppsAccess defines and detects segregation-of-duties conflicts, either preventing 
them from occurring or uncovering them so that they can be properly managed. 

These applications are installed on the database and forms servers on which Oracle 
Applications run. The installation process implements the following architecture: 

• Database Schema: Installation requires the identification of a schema for use by 
Logical Apps applications. Logical Apps recommends strongly the creation of a 
new schema named XXLAAPPS. However, a user who has already established a 
schema for third-party products may choose to use that schema instead.  
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• Tablespace: Logical Apps recommends creating a tablespace for indexes used by 
Logical Apps database objects. (An already established tablespace may be used.)  

• Database Objects: AppsRules makes use of database tables, packages, sequences, 
and workflows, which are placed in the XXLAAPPS (or user-specified) schema. All 
Logical Apps table names begin with the prefix LA.  

• Application Server Objects: AppsRules uses custom forms, which are installed on 
the application server. Custom forms are located in the $XXLAAPPS_TOP/forms/US 
directory.  

• Program Executables: AppsRules uses program executables to report on, migrate, 
and compile business rules. The following objects are installed on the concurrent 
manager server (typically the database server): reports, programs, and Java files. 
Custom programs are located in the $XXLAAPPS_TOP/forms/US directory; some 
executable programs may also reside in the $XXLAAPPS_TOP/bin directory. 

Logical Apps provides two comprehensive Installer programs that place AppsRules 
applications on the database and forms servers. (In addition, they install AppsCore, a 
rules engine that provides functionality to the applications.) Each Installer may be 
run in either of two modes: 

• GUI: The Installer presents a series of windows that prompt you to provide infor-
mation necessary for the installation. Each window also provides access to a help 
file. As you progress through the windows, you can return to windows you had 
completed earlier in order to review or change the entries in them. (The Installer 
retains any entry you don’t change, even if you return to a step earlier than the 
one in which such an entry was made.) GUI mode is the default. 

• Console: The Installer presents a series of command prompts in a UNIX con-
sole, in response to which you provide information necessary for the installation. 
Console mode prompts for the same information as GUI mode, but does not 
enable you to return to earlier prompts and does not provide help screens.  

To run each Installer program, you would type its name — ladbinstall.bin or 
lafrminstall.bin — at the UNIX command prompt. The name alone launches the 
GUI mode; the name along with the argument –i console launches the console mode.  

Preparatory Procedures 
Before installing AppsRules, ensure that the following requirements have been met: 

• Grant the following APPS schema objects the select privilege to the XXLAAPPS 
schema: 

– FND_FILE — Package Spec and Body 

– FND_PROFILE — Package Spec and Body 

• Confirm that Java is in your path. Type the following at the UNIX command 
prompt: 
which java  
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• Verify that you use Java version 1.3 or higher. Type the following at the UNIX 
command prompt: 
java -version 

If more than one copy of Java exists on your system, verify the version on the 
copy in the opt directory (for example, /usr/opt1.3/bin/java). 

• Ensure that the Oracle Advanced Security product is installed. (Logical Apps 
uses DBMS_Obfuscation for encrypting the password.) Type the following at 
the UNIX command prompt:  
adapters 

Look for Oracle Security Server Authentication Adapter among the return 
values. 

• Each of your database server, forms server, and concurrent manager server may 
run on its own host machine. If so, complete the following tasks to confirm that 
the host machines communicate properly: 

– Send a file via FTP from the database server to the concurrent manager 
server, and from the concurrent manager server to the forms server. 

– Perform a remote execution of the shell file, by any of the following 
methods: Enable rsh (remote shell), enable ssh (secured shell), have a 
common mount point, manual. 
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Chapter 2 

Installing AppsRules Suite  

In broad terms, the AppsRules Suite installation process involves four steps: 
1 Create a tablespace for Logical Apps indexes, and a custom database user/schema. 

Logical Apps recommends strongly that the user/schema be named XXLAAPPS.  
2 Run the Installer program to place Logical Apps tables, packages, sequences, and 

workflows on the database server. All Logical Apps table names begin with the pre-
fix LA, and all tables reside in the XXLAAPPS schema. The database server installa-
tion must precede the forms server installation. 

3 Run the Installer program to place Logical Apps forms on the forms server. All 
custom forms are located in the $XXLAAPPS_TOP/forms/US directory.  

4 Configure a remote compilation feature, which makes libraries resident on the 
concurrent sever available to the forms server. 

Creating a User and Tablespace 
To begin the installation process, download the file LOGICALAPPS.zip to a temporary 
directory on your local system from the FTP site provided by Logical Apps. From it, 
extract the two files — ladbinstall.bin and lafrminstall.bin — you will run for data-
base and forms installation. 
Next, create the Logical Apps tablespace and database user/schema. The latter must 
be granted the connect and resource privileges in the Oracle Applications database. 
Logical Apps recommends using the name XXLAAPPS for the new user, and creating 
all Logical Apps database objects in the XXLAAPPS schema. 
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The following is a sample SQL script that can be used to create the user: 
CREATE USER XXLAAPPS 
IDENTIFIED BY XXLAAPPS 
DEFAULT TABLESPACE &DEF_TSPACE 
TEMPORARY TABLESPACE &TMP_TSPACE 
QUOTA UNLIMITED ON &DEF_TSPACE 
QUOTA 0K ON SYSTEM; 

GRANT CONNECT TO XXLAAPPS; 
GRANT RESOURCE TO XXLAAPPS; 

Allocate a minimum of 80 megabytes of space, 40 on the tmp directory and 40 on 
the file system from which the installer is to be launched. 

Installing Database Server Components 
To install database server components of AppsRules, run the file ladbinstall.bin: 

1 Transfer the ladbinstall.bin file to the database server, via FTP in binary mode. 
Use the applmgr account. 

2 Use applmgr to log in to the database server. Ensure that the user (login ID) has 
write and read privileges on $APPL_TOP. 

3 Execute the environment file, if it is not included in the profile: 
$..$APPL_TOP/$APPLFENV 

4 Set the execute permission on ladbinstall: 
$.chmod +x ladbinstall.bin 

5 Execute ladbinstall.bin. Use the file name alone to run the Installer in GUI 
mode; add the argument –i console to run the Installer in console mode. 

As noted earlier, the Installer’s GUI and console modes prompt for the same infor-
mation. If you choose GUI mode (as shown in the following procedure for using the 
installer), you can perform these operations in each of the windows: 

• Review a brief description of the information you need to provide. 

• Click on the Help button to open a window that provides a more expansive 
description of the information you need to provide. (After you review this 
information, click on the Close button to exit the Help window.) 

• Type installation information in the labeled text boxes (or accept default values). 

• When you complete one window, click on the Next button to move from it to 
the next window. 

• Click the Previous button if you wish to return to a window you completed 
earlier. 

• Note that the titles of the windows you are to complete appear in a column along 
the left of each window. Those yet to be completed are shown in grey; windows 
that have been completed are shown in black.  
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To complete the database server installation: 

1 Enter your customer name and license key as they were provided to you by Logical 
Apps. The fields are case-sensitive. When you click Next, a message displays the 
applications you are licensed to install; click the OK button to clear the message. 

 
2 Specify a staging directory — a temporary location for source files: 

 
The Installer suggests a default directory; its name is a timestamp for the moment 
you perform the installation, with DB (for database). If you wish to select another 
directory, click the Choose button and, in a Select a Folder window, navigate to 
the directory you want. If you specify a nonexistent directory, the Installer creates 
that directory. If you navigate away from the default directory and want to return 
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to it, click on the Restore Default Folder button. Make a note of the directory 
name; you’ll need it later, when you configure remote compilation. 

3 Verify the default values for the host name, SID (service identifier) and network 
port of the Oracle Applications database server, which the Installer takes from 
the shell environment. If the defaults are not correct, enter correct values. 

 
4 Supply log-on values for the Logical Apps and Oracle Applications (APPS) schemas: 

 
As noted earlier, Logical Apps recommends strongly the creation of a dedicated 
schema called XXLAAPPS, and the Installer provides this value by default. If you 
follow the recommendation, accept the default; otherwise, replace it with the 
name of the schema you will use for Logical Apps database objects. Also enter 
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the passwords for the Logical Apps and Oracle APPS schemas, and the name of 
the tablespace for indexes used by Logical Apps database objects. 

5 Establish the Logical Apps TOP — the high-level directory for the storage of 
AppsRules files. Specify a directory that is the parent of the Logical Apps TOP 
and an application short name that is appended to the parent directory to form 
the Logical Apps TOP directory. 

 
By default, the Installer selects the Oracle Applications TOP as the parent direc-
tory and XXLAAPPS as the application short name. These values are recommended, 
but you can change them. (To select another parent directory, click on the Choose 
button and, in a Select a Folder window, navigate to the directory you want. If 
you enter the name of a nonexistent directory, the Installer creates that directory. 
To return to the default directory, click the Restore Default button.) 

If you have selected an application short name that is already in use, the Installer 
displays a warning message when you click the Next button:  

 
To respond to this warning: 

• Click Enter Again to return to the Application TOP form and set a new value. 

• Click Continue to accept the duplicate application short name. Doing so, how-
ever, would cause AppsRules and another application to share the name, with 
the risk that files for one application or the other might be overwritten. 

• Click Abort to abandon the AppsRules installation. 
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6 Specify paths to files that contain environment variables for the Oracle Applica-
tions shell. (The installation appends Logical Apps-specific entries to these files.) 

 
Accept the defaults, or click a Choose button and, in a Select a Folder window, 
navigate to a directory you want. If you enter the name of a nonexistent direc-
tory, the Installer creates that directory. To return to the default directory, click 
the Restore Default button. 

7 Review your selections in the Input Summary form: 

 
If you determine that any of the entries is inappropriate, you can click on the 
Previous button until you reach the form in which you selected the entry, and 
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change it. (The Installer retains any entries you don’t change, even if you pass by 
them as you return to an earlier step in the installation process.)  

8 Note that in the Input Summary form, the label for the button at the lower right 
has changed from Next to Install. When you are satisfied with the selections you 
have made in preceding forms, click on the Install button to complete the data-
base server installation. 

The Installer displays error messages (if any are warranted) upon completing the instal-
lation of each Logical Apps application, and displays an overall status upon completing 
the installation of all products. If the overall status is Success, the installation has fin-
ished with no errors.  

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or 
Fatal, depending on severity. The Installer recovers (restores the system to its state 
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For 
details about errors and the installation process, navigate to the directory from which 
the Installer ran and review two log files: LADB_LOG_timestamp.log and LADB_ERROR_ 
timestamp.log, where timestamp is the date and time at which the Installer ran. 

Installing Forms Server Components 
To install forms server components of AppsRules, run the file lafrminstall.bin: 

1 If the database and forms servers run on the same host, re-source the environ-
ment by opening a new shell.  

2 Transfer the lafrminstall.bin file to the forms server, via FTP in binary mode. 
Use the applmgr account.  

3 Use applmgr to log in to the forms server. Ensure that the user (login ID) has 
write and read privileges on $APPL_TOP. 

4 Execute the environment file, if it is not included in the profile: 
$..$APPL_TOP/$APPLFENV 

5 Set the execute permission on lafrminstall: 
$.chmod +x lafrminstall.bin 

6 Execute lafrminstall.bin. Use the file name alone to run the Installer in GUI 
mode; add the argument –i console to run the Installer in console mode. 

Most windows (or console prompts) for the forms installation are identical to those 
for the database installation. If you select GUI mode, each window enables you to per-
form the same operations as you could in the database-server Installer (see page 6).  

To complete the forms server installation: 

1 In the License Key window, once again enter the customer name and license key 
provided to you by Logical Apps. These are the same as the values you entered 
for the database-server installation. Once again, when you click the Next button 
a messages displays the applications you are licensed to install; click the OK but-
ton to clear the message. 
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2 In the Staging form, once again select a directory for the temporary placement of 
source files. The Installer once again suggests a default — its name this time a time-
stamp for the moment you perform the installation, along with FRM (for forms).  

If you wish to select another directory, click on the Choose button. In a Select a 
Folder window, navigate to the directory you want. If you specify a nonexistent 
directory, the Installer creates that directory. If you navigate away from the default 
directory and want to return to it, click on the Restore Default Folder button. 

3 In the Database Host form, select the database host name used where the data-
base installation has been run, and the appropriate SID and port values. 

4 The Database Schema window is changed slightly from its corresponding win-
dow in the database-server Installer program. There is no longer an Index Table 
Space field (as that field would be inapplicable to forms installation), but where 
the database-server Installer requested only a password for the Oracle Applica-
tions schema, the forms-server Installer asks for a name as well: 

 
For the Apps Schema field, accept the default value, APPS. (This needs to match 
the database-server value, which is hard-coded.) For each of the remaining fields, 
enter the same value as you entered for the database installation.  

Once again, Logical Apps recommends strongly the creation of a dedicated 
schema called XXLAAPPS, and the Installer provides this value by default. If you 
follow the recommendation, accept the default; otherwise replace it with the 
name of the schema you will use for Logical Apps database objects. Also enter 
the passwords for the Logical Apps and Oracle APPS schemas. 

5 In the Application TOP form, establish the Logical Apps TOP for the forms 
server — the highest-level directory for the storage of AppsRule files. Specify a 
directory that is to serve as the parent of the Logical Apps TOP, and an applica-
tion short name that is appended to the parent directory to form the Logical 
Apps TOP directory. 



 Chapter 2: Installing AppsRules Suite  

AppsRules Suite Installation Guide  13 

The Installer defaults to the forms-server-specific Oracle Applications TOP as 
the parent directory and XXLAAPPS as the application short name. These values 
are recommended. 

Ensure, however, that the application short name for the forms server is the same 
as the one you selected for the database server. If you wish to select another par-
ent directory, click on the Choose button and, in a Select a Folder window, navi-
gate to the directory you want. If you enter the name of a nonexistent directory, 
the Installer creates that directory. To return to the default directory, click the 
Restore Default button.   

The forms-server Installer, like its database-server counterpart, presents a warn-
ing if you select an application short name that is already in use and it presents 
the same response options: 

• Click Enter Again to return to the Application TOP form and set a new value. 

• Click Continue to accept the duplicate application short name. Doing so, how-
ever, would cause AppsRules and another application to share the name, with 
the risk that files for one application or the other might be overwritten. 

• Click Abort to abandon the AppsRules installation. 

6 In the Environment form, specify paths to files that contain environment var-
iables for the Oracle Applications shell. (The installation appends Logical Apps-
specific entries to these files.) Accept the defaults, or click a Choose button and, 
in a Select a Folder window, navigate to a directory you want. If you enter the 
name of a nonexistent directory, the Installer creates that directory. To return to 
the default directory, click the Restore Default button. In any case select values 
that are appropriate for the forms server. 

7 When you complete the Environment form, the forms server Installer presents a 
CUSTOM.pll form: 
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Forms server installation requires that an existing CUSTOM.pll file be modified so 
that it can link to an LACUSTOM.pll file. If you select Yes, the Installer backs up 
your existing CUSTOM.pll, and then overwrites the original with a modified copy 
that contains the necessary links to LACUSTOM.pll. (The backup copy has a time-
stamp appended to the .pll file extension.) If your existing CUSTOM.pll contained 
any customization, a Yes selection in this form would require you to copy your 
customizations manually from the backup file to the Logical Apps-provided 
CUSTOM.pll. 

If you select No, the Installer retains your existing CUSTOM.pll. In this case, you 
need to edit the file to insert links to LACUSTOM.pll (see below). 

8 In the Input Summary form, review the selections you have made. If you deter-
mine that any of the entries is inappropriate, you can click on the Previous but-
ton until you reach the form in which you selected the entry, and change it.  (The 
Installer retains any entries you don’t change, even if you pass by them as you 
return to an earlier step in the installation process.)  

9 When you are satisfied with the selections you have made in preceding forms, 
click on the Install button in the Input Summary form to complete the forms 
server installation. 

The Installer displays error messages (if any are warranted) upon completing the instal-
lation of each Logical Apps application, and displays an overall status upon completing 
the installation of all products. If the overall status is Success, the installation has fin-
ished with no errors.  

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or 
Fatal, depending on severity. The Installer recovers (restores the system to its state 
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For 
details about errors and the installation process, navigate to the directory from which 
the Installer ran and review two log files: LAFRM_LOG_timestamp.log and LAFRM_ERROR_ 
timestamp.log, where timestamp is the date and time at which the Installer ran. 

CUSTOM.pll Modifications 
If you chose (in step 7) not to overwrite your CUSTOM.pll file, edit the CUSTOM.pll 
file. (If you selected Yes in step 7, ignore this section and skip ahead to “Configuring 
the Remote Compilation.”) 

1 In place of the existing code for Procedure Event(event_name varchar2), substitute the 
following: 
PROCEDURE event(event_name varchar2) is  
 
  form_name varchar2(30) := name_in('system.current_form');  
  block_name varchar2(30) := name_in('system.cursor_block');   
  field_name varchar2(30) := name_in('system.current_item'); 
  function_name varchar2(30); 
  parameters  varchar2(2000); 
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begin  

  if (event_name = 'ZOOM') then    
    la_enhncmtmgr_pkg.la_zooms(form_name,block_name,function_name, 
        parameters); 
      if function_name is not NULL 
      then 
        if parameters is null then 
          fnd_function.execute(function_name,'Y','N'); 
        elsif 'ZOOMSPECIAL' = substr(parameters,1,11) then  
          lacustom.event('ZOOMSPECIAL'); -----new code 081903 
      else 
        parameters := lazoom.zoom_event(parameters); 
        fnd_function.execute(function_name,'Y','N',parameters); 
      end if; 
  end if; 
-----------------------------------WNF 
  elsif (event_name='WHEN-NEW-FORM-INSTANCE') then 
 lacustom.event('WNF'); 
---------------------------WNB 
  elsif (event_name = 'WHEN-NEW-BLOCK-INSTANCE') then 
 lacustom.event('WNB'); 
------------------------------WNI 
  elsif (event_name = 'WHEN-NEW-ITEM-INSTANCE') then 
 lacustom.event('WNI'); 
------------------------WNR 
  elsif (event_name = 'WHEN-NEW-RECORD-INSTANCE') then  
 lacustom.event('WNR'); 
------------------------WNV 
  elsif (event_name = 'WHEN-VALIDATE-RECORD') then 
 lacustom.event('WVR'); 
------------------------ 
  elsif (substr(event_name,1,7) = 'SPECIAL') then 
 execute_menu(event_name); 
-------------------------------------------- 
   else lacustom.event(event_name);   --put other events here 
   end if; 
end event; 

2 In place of the code for Function zoom_available, substitute the following: 
FUNCTION zoom_available return boolean is 
    v_enabled varchar2(20); 

  begin   --x 
    v_enabled := lazoom.zoom_enabled; 
    IF v_enabled = 'TRUE' THEN  
      return TRUE;  
    else  
      return FALSE;  
    end if;  
  RETURN NULL;  
  end zoom_available; 

3 Attach the following libraries. (Remove the path when attaching the libraries.) 

• LACUSTOM.pll 

• LABRSQL.pll 

4 Compile the file and ensure there are no compilation errors. 
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Configuring the Remote Compilation 
To finish the installation, you must configure a remote compilation feature, which 
makes libraries resident on the concurrent sever available to the forms server. 

1 Log on to the database server. 

2 If you don’t already know it, determine the full path to the Java executable. At 
the command prompt, type: 
which java 

3 Navigate to the staging directory (which you selected in step 2 of the database 
server installation process).  

4 Grant the execute permission on a file called laconfig.sh: 
chmod +x AppsCore/db/scripts/laconfig.sh 

5 Run the laconfig.sh file: 
AppsCore/db/scripts/laconfig.sh arg1 arg2 

• In place of arg1, insert the full path of the Logical Apps TOP directory, 
followed by “/bin.” Note that the path to the Logical Apps TOP directory 
typically contains more than the values you selected in step 5 of the database 
server installation process. To determine the path to this directory, use the 
echo command, specifying the application short name you selected in step 5 
of the database server installation, followed by “_TOP.” For example: 
echo $XXLAAPPS_TOP 

As an example of a correct value for arg1, the path to the Logical Apps TOP 
configured on page 9 might be: 
/oracle/bin/ebiz115/appl/XXLAAPPS/11.5.0/bin 

• In pace of arg2 insert the full path of the staging directory (which you 
selected in step 2 of the database server installation process), followed by 
“/AppsCore.” For example, the correct value for the staging directory 
configured on page 7 might be: 
/export/home/oracle/rkstage/DB_27Jun2005_134434/AppsCore 

Running the laconfig.sh file produces a series of command-line prompts. Respond to 
them as follows: 

1 Enter the full path of the Java executable. 

2 The following prompt appears: 
Choose your Configuration from below: 
1.  Single-Tier (all tiers on a single node) 
2.  Multi-node (a separate node for each server) 
3.  Two Node (one database/concurrent proc. node, one  
    forms/web node) 
4.  Two Node (one forms/concurrent proc. node, one database 
    node 
5.  Exit Program 
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Enter 1 if all of the database, forms, and concurrent servers reside on a single 
machine; enter 2 if each resides on its own machine; enter 3 if the database and 
concurrent servers reside on one machine, and the forms server on another; enter 
4 if the forms and concurrent servers reside on one machine, and the database 
server on another.  

3 The following prompt appears: 
Environment File is 'filename' 
Does this environment file set Oracle Home (Y/N) 

Select Y for yes or N for no as appropriate. If you select N, the system prompts 
you for the name of the file that does set the Oracle Home; enter the file name. 

4 If you selected option 2, 3, or 4 in step 2, the following prompt appears: 
Choose the execution method from below: 
1) Secured Shell — ssh 
2) Remote execution — rexec 
3) Manual 

Enter the number corresponding to the protocol you will use for communication 
among the machines on which your servers reside. 

5 If you selected option 2, 3, or 4 in step 2, the following prompt appears: 
Enter the Number of Form Servers: 

Enter the number of form servers you have. 
6 The following set of prompts appears once for each of the form servers you enu-

merated in step 5 (with the x replaced by a form server number): 
Enter the Form Server Number x Host Name: 
Enter the Login ID: 
Enter the Password: 
Enter the full path of Logical Apps binaries on the FORM 
Server: 

For each set of prompts, enter the host name, the login ID for the owner of 
APPL_TOP, that owner’s password, and the appropriate path. You can get the last 
of these values by logging on to the form server and typing the following command: 
echo @XXLAAPPS_TOP_bin 

Once you have finished executing the laconfig.sh file, verify that the following files 
exist and make sure both the Java path and Classpath are set correctly: 

• Database server (under $XXLAAPPS_TOP/bin): LAGENLIB.prog, LAMIGRATE.prog, 
LAIMPORT.prog 

• Forms server: LAFORMSGEN.prog 
Finally, if you want to enable migration (the ability to port AppsRules configurations 
from one instance to another) with password security: 

1 Navigate to \\System Administration Responsibility\Profile\System. 
2 Query for the LAAPPS: Enable Migration Security profile option. 
3 Set the value to Yes at site level. (This can be controlled further at the responsi-

bility and user levels.) 
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Bouncing the Servers 
When you finish configuring the remote compilation feature, bounce both the form 
server and the concurrent manager server. 
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Chapter 3 

Postinstallation Tasks  

Once the installation is complete, you must perform additional tasks specific to the 
applications you’ve installed. 

AppsFlow 
To use AppsFlow, run the Synchronize WF LOCAL Tables concurrent program: 

1 Log on to the System Administrator responsibility in Oracle Applications. 
2 Click on View in the Oracle Applications menu bar, then on Requests in the 

View menu. The Find Requests form appears. 
3 Click the Submit a New Request button. At the prompt, select Single Request 

and click OK. The Submit Request form appears. 
4 In the Name list of values, select Synchronize WF LOCAL Tables. Click on the 

OK button. 
5 A Parameters form appears. Enter the following values (as shown at the top of the 

next page), then click on the OK button: 
• Orig System: ALL 
• Parallel Processes: 1 
• Logging Mode: LOGGING 
• Temporary Tablespace: Choose an appropriate temporary tablespace. 

6 In the Submit Request form, click on the Submit button. 
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AppsAudit 
To use AppsAudit, complete three tasks. First, set the AuditTrail:Activate profile 
option to Yes: 

1 Log on to the System Administrator responsibility in Oracle Applications. 

2 In the Navigator, select Profile, then System.  

3 In the Find System Profile Values form, select AuditTrail:Activate in the Profile 
list of values. Then click on the Find button. 

4 Ensure that the AuditTrail:Activate option is set to Yes at the Site level: 

 
Second, add the LACSVREPORT style to the printer you will use for AppsAudit: 

1 In the System Administrator responsibility, select Install, then Printer, then Register.  

2 A Printers form appears. In its Printer list of values, select the printer you wish 
to use with AppsAudit. Note the value that appears in the Type field when you 
select the printer, and then click on the Printer Types button. 

3 A Printer Types form appears. In its Type field, query for the Type you noted in 
step 2. (Press the F11 key; enter the Type value in the Type field; press Ctrl+F11.) 
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4 In the Style list of values, select LACSVREPORT. (The software automatically 
supplies an associated value under Driver Name.) 

 
5 Click on File in the menu bar, then on Save in the File menu. 

Third, modify the report style: 

1 Still in the System Administrator responsibility, select Concurrent, then Program, 
then Define. 

2 A Concurrent Programs form appears. In its Program field, query for Logical 
Apps AppsAudit Report. (Press the F11 key; enter Logical Apps AppsAudit Report 
in the Program field; press Ctrl+F11.) 

3 The Style field displays the value Landwide. Change this to Landscape. 

  
4 Click on File in the menu bar, then on Save in the File menu. 
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AppsAccess and AppsControl 
To use AppsAccess you must import two xml files, and to use AppsControl you 
must import three xml files. To do so, you use a migration utility, which the Installer 
programs set up automatically as a part of the installation process. 

First, ensure that the migration utility is configured correctly: 

1 Log on to the Logical Apps responsibility in Oracle Applications. In that respon-
sibility, select AppsRules. 

2 Once the AppsRules form is open, click on Logical Apps Utilities in the menu 
bar, then on Migration Setup in the Utilities menu.  

3 A Migration Utility form appears. Ensure that the Setup Host Names tab is selected: 

 
4 Confirm that the database server host name (the one selected in step 3 of the 

database server installation process) is displayed in the Host Name column. The 
Installer program should have inserted this value during installation. 

5 Click on the Setup Instances tab: 

 
6 Ensure that appropriate values are displayed in the Host Name, Instance (SID), 

Port Number, User Name, and Password columns. (The first three values are 
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those specified in step 3 of the database server installation process, and the last 
two are those specified in step 4.) Again, the Installer should have inserted these 
values automatically. 

7 Having confirmed these values (or, if necessary, entered them), close the 
Migration Utility form. 

The five xml files are located in subdirectories of the staging directory you selected in 
step 2 of the database server installation process. For AppsAccess the files are located 
in StagingDirectory/AppsAcces/db/scripts, and include the following: 

• laa_apps_access_rule.xml 
• laa_apps_access_flow.xml 
For AppsControl the files are located in StagingDirectory/AppsControl/db/scripts, and 
include the following: 

• appscontrol_notification.xml 
• appscontrol_approval.xml 
• appscontrol_reject.xml 
For each application, the files must be imported in the order shown. Complete the 
following procedure once for each of the files: 

1 With AppsRules open, click on Logical Apps in the menu bar, then on Import 
from File in the Utilities menu. An Import from File form appears: 

 
2 In the directory box, type the path to the folder that contains the import file. 

3 In the File Name box, type the name of the file you want to import. 

4 Select a value for Debug Level. Ordinarily, select Low; select High instead if you 
need to uncover the cause of a failed import. 

5 Click on the Import button. A concurrent request message displays the ID num-
ber of the concurrent request under which the import operation is carried out. 
Click on the OK button to clear the message. 
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AppsAccess Concurrent Program 
If you are upgrading AppsAccess from an earlier version, the name of one of its con-
current programs may not have been updated correctly. To correct the program name: 

1 Log on to the System Administrator responsibility in Oracle Applications. 

2 In the Navigator, select Concurrent, then Program, then Define. The Concurrent 
Programs form opens. 

3 Query for the Conflict Data Purge program: Press F11, type the phrase LA 
AppsAccess Conflict Data Purge in the Program field, and press Ctrl+F11. 

 
4 In both the Program and Description fields, type the following new value for the 

name of the program: LA AppsAccess Archive User Conflict Data. Do not change 
any other values. 

5 Save the change: Click on File in the menu bar, and then Save in the File menu. 
Then close the Concurrent Programs form (click on the × symbol). 

If you are performing a new installation of AppsAccess, this issue does not arise; the 
program is named correctly, and you need not take any corrective action. 

Special Cases 
If the database server and concurrent manager server are on different hosts, make 
the following changes to the TKprof script (LATKPROF.prog), which is located in the 
Logical Apps binary directory on the concurrent manager server. (The changed lines 
are shown in boldface.) The value <db_login> is the database server name, and the 
value <db_hostname> is the user name to log on to the database server. 
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#!/bin/sh 
oracle_login=$1 
tempfile=$$latkprof.txt 
temptrc=$$latkprof.trc 
echo Temp file $tempfile 
echo tkprof directory "$5" 
pwd 
tkfiles=`ssh <db_login>@<db_hostname> ls $5` 
for i in $tkfiles 
do 
echo processing $i 
scp <db_login>@<db_hostname>:$i /tmp/$temptrc 
tkprof /tmp/$temptrc /tmp/$tempfile explain=$1 
cat /tmp/$tempfile 
rm /tmp/$tempfile 
rm /tmp/$temptrc 
done 

If you have multiple APPS schemas, the LA_ENHNCMTMGR_PKG must be created as 
a synonym under each of these schemas. To perform this operation, run the 
following command: 

create synonum LA_ENHNCMTMGR_PKG for apps.LA_ENHNCMTMGR_PKG 

If this is not set, the following error message appears when a user attempts to log on 
to a read-only or MRC (multiple reporting currency) responsibility: 

la_enhncmtmgr_pkg not declared 
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Chapter 4 

Validation  

As a part of the installation process, the Installer programs complete several 
“behind-the-scenes” tasks. Open Oracle Applications forms to confirm that these 
tasks have been completed. (As you perform these validation steps, you may be 
instructed to “query for” a value. If so, press the F11 key, type the specified value in 
a specified field, and press Ctrl+F11.) 

1 Log on to the System Administrator responsibility in Oracle Applications. 

2 Select Application, then Register.  

3 In the Application field, query for Logical Apps Custom. The form should 
contain the following values: 
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4 Switch to the Application Developer responsibility. (Select File in the menu bar, 
then Switch Responsibility in the File menu; then select Application Developer 
in the Responsibilities form.) In the Application Developer Navigator, double-
click on Application, then Form. In the Form field, query on LABIZ. The form 
should contain the following values: 

 
5 Switch back to the System Administrator responsibility. In its Navigator, select 

Security, then Responsibility, then Request. In the Request Groups form, query 
for the Logical Apps Request Group. The form should contain the following 
values: 
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6 Still in the System Administrator responsibility, select Application, then Menu in 
the Navigator. In the Menus form, query for LAAR_NAVIGATE and confirm the 
values shown in the following illustration. (Note that the illustration is a compos-
ite, showning entries that would appear if you were to use the scroll bar in the 
Menus form.) 

 
If you are upgrading from an earlier version, the menu may contain an obsolete 
item and may lack two new items. Check that entries appear at sequence numbers 
205 and 210, and contain the following values. If not, create the entries manually. 

• Sequence 205: Prompt is “AppsAccess - Define Conflict Rules”; Submenu is 
blank; Function is “AppsAccess Define Conflict Rules”; Description is 
“AppsAccess - Define Conflict Rules”; Grant box is checked. 

• Sequence 210: Prompt is “AppsAccess - User Conflict Approval”; Submenu 
is blank; Function is “AppsAccess User Conflict Approval”; Description is 
“AppsAccess - User Conflict Approval”; Grant box is checked. 

Also, delete an entry with the value “AppsAccess” in the Prompt and Function 
columns, if one exists. 
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7 In the System Administrator Navigator, select Security, then Respponsibility, 
then Define. In the Responsibilities form, query for Logical Apps. (This is the 
responsibility you would assign to Oracle Applications User so that they can use 
Logical Apps applications.) 

 
Switch to the Logical Apps responsibility and, in the Logical Apps Navigator, select 
AppsRules. Then do the following: 

1 Select Tools in the menu bar, then Logical Apps Configuration in the Tools 
menu. 

2 An AppsRules Configurations form appears. Confirm that a value displayed in 
the UTL Path field: 

 
3 The UTL Path field value should match the name of one of the directories set 

for UTL PATH in your environment. To confirm that it does, run the following 
SQL query to generate a list of those directories: 
select value from gv$parameter where name='utl_file_dir' 
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Finally, confirm that appropriate values have been set for AppsRules libraries: 

1 With AppsRules open, click on Logical Apps Utilities in the menu bar, then on 
AppsRules Libraries in the Logical Apps Utilities menu. 

2 With a Logical Apps Libraries form open, click on Tools in the menu bar, then 
on Value Sets in the Tools menu. 

3 In the Name field of the Find Value Set form, enter the value LA% and click on 
the Find button. 

 
4 Select (one at a time) the LAAC_CATEGORY, LAAR_LIBRARY_MODULES, and 

LAAR_LIBRARY_THEME entries. For each, confirm that a Segment Values form 
displays the value ALL in the Values field of the Values, Effective tab. For 
example: 
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Installation History 
You can review information about the installation of files for your AppsRules imple-
mentation. To do so: 

1 Log on to the Logical Apps responsibility. 

2 In the Navigator, select Install History. The Installation History form appears: 

 
Each row provides information about the installatin of a LogicalApps program 
element — for example, the top row in this illustration shows that the AppsCore 
element for version 6.5.3 of the forms server was successfully installed. Because 
there are several elements for each of the forms and database servers, a single 
installation of AppsRules fills multiple rows in the grid — for example, all of the 
rows in this illustration pertain to an installation performed on the seventh of July. 

3 To view a list of the files installed for a given element, click on the row for that 
element and then on the Installed Files button. The following form appears: 

 
Click on the Close button to clear this form. 
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4 Finally, to review information about all currently installed files (regardless of 
whether they were added in the most recent installation), click on the Current 
File Versions tab: 

 
5 To close the Installation History form, click on its × symbol. 
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